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ADO	Reports	
Report	generation	and	performance	have	been	improved	with	EMu	5.0	and	it	 is	now	
possible	to	report	directly	to	an	Open	Database	Connectivity	(ODBC)	data	source	and	to	
an	ActiveX	Data	Objects	(ADO)	RecordSet	object,	bypassing	the	ODBC	filtering	process.	

The	new	report	options	are:	

 Crystal	 Reports:	 report	 directly	 in	 ODBC	 format,	 bypassing	 the	 ODBC	 filtering	
process.	

 Crystal	 ADO:	 report	 using	ADO	RecordSets	 for	 Crystal	 (which	 are	 accessible	 via	
Crystal's	ADO	connector).	

 Microsoft	ADO:	report	using	ADO	RecordSets	for	Microsoft	products.	

	 Crystal	 and	 Microsoft	 reports	 (Excel,	 Power	 Point	 and	 Word)	 which	
currently	connect	to	an	ODBC	data	source	can	be	modified	to	use	an	ADO	
RecordSet.	
It	remains	possible	to	create	reports	by	connecting	directly	to	an	ODBC	
data	source.	

 

Note	
This	 document	 assumes	 familiarity	 with	 Report	 creation	 in	 EMu.	 Full	 details	 about	
Report	Creation	are	available	in	the	EMu	Help:	Working	with	EMu	records>Reports.	
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Crystal	Reports	
Creating	a	Crystal	Report	using	the	new	ADO	RecordSet	is	similar	to	creating	a	Crystal	
report	with	a	direct	ODBC	connection.	The	main	differences	are	in	selecting	the	data	
source.	This	document	describes	the	differences.	

 

How	to	create	a	Crystal	ADO	Report	
In	EMu:	

1. Search	for	or	otherwise	list	a	group	of	records	on	which	to	report.	

	 When	designing	a	Crystal	ADO	report	the	records	in	your	initial	record	set	
must	have	a	value	in	each	field	to	be	included	in	the	report.	If	not,	the	field	
name	will	not	appear	in	the	list	of	available	columns.	Once	the	report	is	
defined,	it	does	not	matter	if	a	record	does	not	have	values	in	every	field	
included	in	the	report.	

2. Click	Reports	 	 in	the	Tool	bar	to	display	the	Reports	box.	

3. Click	 	 in	the	Reports	box.	
The	Report	Properties	box	displays.	

4. Enter	a	descriptive	name	for	the	Report	in	the	top	text	field.	
5. Select	Crystal	ADO	Report	from	the	Type	drop	list:	

S E C T I O N 	 2 	



Crystal Reports 
 

 

4 
 

ADO Reports

 

	
6. On	the	Fields	tab,	add	the	fields	to	be	included	in	the	report.	

In	this	example	the	fields	selected	are:	
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Note	that	a	group	was	created	using	the	Create	Group	 	 button.	
7. Make	changes	on	the	other	tabs	as	required.	

See	the	EMu	Help	for	details	about	setting	a	sort	order,	sort	options,	and	security.	

8. Click	 .	
The	new	report	is	added	to	the	Reports	box.	

9. In	the	Reports	box,	select	the	new	report	and	click	 	 to	run	the	report	
for	the	first	time.	
A	message	will	display	indicating	that	your	report	does	not	exist	on	the	server.	This	
is	to	be	expected	as	the	report	has	not	yet	been	built	in	Crystal	Reports:	

	

10. Click	 .	
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An	xml	file	is	generated	and	saved	with	the	data	from	your	record	set.	The	location	
of	this	file	can	vary,	but	typically	it	can	be	found	in:	
C:\Users\[your	username]\AppData\Local\KESoftware\Reports\e[module	
name]	
For	example,	a	report	run	in	the	Parties	module,	will	save	the	xmldata	file	to:	
C:\Users\[your	
username]\AppData\Local\KESoftware\Reports\eparties	
The	Crystal	Reports	Designer	application	will	open.	

11. On	the	Start	Page	of	the	Crystal	Reports	Designer,	select	Blank	Report	under	the	
New	Reports	heading	
‐OR‐	
Select	File>New>Blank	Report	in	the	Menu	bar.	
The	Database	Expert	box	displays:	
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12. Double‐click	Create	New	Connection	and	click	 	 beside	ADO.NET	(XML):	
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The	following	screen	will	display:	
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13. Click	the	button	beside	the	File	Path	field	to	locate	and	select	the	xmldata.xml	file	

created	when	the	report	was	first	run	(Step	9).	
See	Step	10	for	details	of	the	location	of	the	xmldata.xml	file.	

14. Click	 	 to	return	to	the	Database	Expert:	
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Group 1	 contains	values	 from	 fields	 that	we	grouped	 in	 the	EMu	report	 in	 this	
example	(see	Step	6).	These	fields	are	tables	of	values	(they	can	hold	more	than	one	
value).	This	data	needs	to	be	added	to	our	report	using	a	sub‐report	(see	the	EMu	
Help	for	details).	
Field	values	from	the	Catalog	are	contained	in	the	table	called	row.	

15. Select	row	and	add	it	to	the	Selected	Tables	pane:	
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16. Click	 .	

The	Crystal	Report	Designer	displays,	ready	for	you	to	design	your	Crystal	report.	
See	the	EMu	Help	for	details	of	designing	a	Crystal	Report.	

	 It	 is	 important	 not	 to	 move	 the	 xmldata.xml	 file	 as	 this	 will	 cause	
problems	when	sharing	the	report	with	other	users.	
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How	to	modify	a	Crystal	Report	to	use	
ADO	instead	of	ODBC	

To	modify	a	Crystal	Report	to	use	ADO	rather	than	ODBC:	

1. Open	the	Report	Properties	dialog	for	the	report.	
This	example	uses	the	default	report	List (A4).	

2. Select	Crystal	ADO	Report	from	the	Type	drop	list:	

	
The	fields	for	this	report	are:	
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Two	tables	are	generated	in	this	report.	

3. Click	 	 and	run	the	report.	
Crystal	will	create	the	ADO	record	set	and	the	following	error	will	display:	

	
4. Open	the	Crystal	report	in	the	Crystal	Report	Designer	and	select	the	Database>Set	

Datasource	Location	menu	option.	
The	Set	Datasource	Location	dialog	will	display:	
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5. Select	 Create	 New	 Connection	 in	 the	 Replace	 with	 pane	 and	 click	 	 beside	

ADO.NET	(XML).	
The	following	screen	will	display:	
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6. Click	the	button	beside	the	File	Path	field	to	locate	and	select	the	xmldata.xml	file	

created	when	the	report	was	run.	
The	location	of	this	file	can	vary,	but	typically	it	can	be	found	in:	
C:\Users\[your	username]\AppData\Local\KESoftware\Reports\e[module	
name]	
For	example,	a	report	run	in	the	Parties	module,	will	save	the	xmldata	file	to:	
C:\Users\[your	
username]\AppData\Local\KESoftware\Reports\eparties	

7. Click	 .	
You	are	returned	to	the	Set	Datasource	Location	dialog:	
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Next	it	is	necessary	to	map	fields	from	the	old	ODBC	data	source	to	the	new	ADO	
RecordSet.	
In	this	example	there	are	two	tables	to	map	and	one	sub‐report.	

8. To	map	the	old	ODBC	Catalog	fields	to	the	new	Catalog	table,	click	ecatalogue_csv	
in	the	Current	Data	Source	pane	and	then	click	the	row	 table	in	the	Replace	with	
pane.	
The	Update	button	will	be	enabled.	

9. Click	the	Update	button	and	the	Map	Fields	dialog	will	display:	
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Fields	with	the	same	name	will	be	mapped	automatically.	

10. Uncheck	the	Match	type	check	box	to	reveal	more	fields	in	the	Unmapped	Fields	
pane:	
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11. Complete	mapping	fields	in	the	Unmapped	Fields	pane.	

In	this	example	we	map	ecatalogue_key	to	ecatalogue_key	and	irn	to	irn	by	
selecting	both	fields	to	map	and	clicking	the	Map	button.	
Once	mapped,	fields	will	be	moved	to	the	Mapped	Fields	pane:	
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12. Click	 	 when	all	fields	are	mapped.	

You	are	returned	to	the	Set	Datasource	Location	dialog.	
13. Repeat	 the	mapping	process	 for	all	 fields	(in	 this	example,	mapping	 fields	 in	 the	

CreatorD_csv	table	to	the	ADO	table	CreatorDetails):	
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14. Once	all	fields	have	been	remapped	in	all	tables	click	Close.	

You	are	returned	to	the	Crystal	design	window.	
If	you	refresh	report	data	at	this	stage	and	you	have	a	sub‐report	object,	you	will	
probably	receive	an	error	regarding	sub‐report	links,	e.g.:	
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Click	 	 to	open	the	Record	Selection	Formula	Editor.	Change	the	link	key	
field	 used	 by	 the	 old	 ODBC	 table	 to	 the	 link	 key	 field	 referenced	 by	 the	 ADO	
RecordSet:	

	

The	report	should	now	work	correctly.	
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Microsoft	Excel	

	 The	following	examples	demonstrate	how	to	create	a	basic	Excel	report	
using	VBA.	Please	note	that	it	is	not	the	intention	of	this	document	to	teach	
VBA.	
Excel	2013	was	used	to	create	these	reports.	

 

How	to	create	an	Excel	Report	using	the	
ADO	RecordSet	

With	ODBC	data	sources	there	is	an	option	in	Excel	to	open	a	connection	without	writing	
Visual	Basic	code.	This	is	not	the	case	when	making	a	connection	to	an	ADO	record	set	
and	it	is	necessary	to	write	VB	code.	
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Step	1:	Create	a	new	report	in	EMu	
This	first	example	is	a	simple	report	on	single	value	fields	from	the	Catalog	module.	The	
VBA	code	provided	in	this	example	will	automatically	populate	headings	and	row	data	
for	each	column	selected.	

In	EMu:	

1. Search	for	or	otherwise	list	a	group	of	records	on	which	to	report.	

2. Click	Reports	 	 in	the	Tool	bar	to	display	the	Reports	box.	

3. Click	 	 in	the	Reports	box.	
The	Report	Properties	box	displays.	

4. Enter	a	descriptive	name	for	the	Report	in	the	top	text	field.	
5. Select	Microsoft	ADO	Report	from	the	Type	drop	list:	

	
6. On	the	Fields	tab,	add	the	fields	to	be	included	in	the	report.	

Fields	selected	in	this	example	are:	
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7. Make	changes	on	the	other	tabs	as	required.	

See	the	EMu	Help	for	details	about	setting	a	sort	order,	sort	options,	and	security.	

8. Click	 .	
The	new	report	is	added	to	the	Reports	dialog	box.	

9. Select	the	new	report	and	click	 	 to	run	the	report	for	the	first	time.	
A	message	will	display	indicating	that	your	report	does	not	exist	on	the	server.	This	
is	to	be	expected	as	the	report	has	not	yet	been	built	in	Excel:	

	

10. Click	 .	
An	xml	file	is	generated	and	saved	with	the	data	from	your	record	set.	The	location	
of	this	file	can	vary,	but	typically	it	can	be	found	in:	
C:\Users\[your	username]\AppData\Local\KESoftware\Reports\e[module	
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name]	
For	example,	a	report	run	in	the	Parties	module,	will	save	the	xmldata	file	to:	
C:\Users\[your	
username]\AppData\Local\KESoftware\Reports\eparties	
Microsoft	Excel	will	open	with	a	blank	worksheet	as	follows:	
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Ensure	that	Excel	is	setup	correctly	

If	the	Developer	tab	does	not	display	in	the	Ribbon:	

1. Click	File>Options>Customize	Ribbon.	
2. With	Main	Tabs	 selected	 from	the	Customize	 the	Ribbon	drop	 list	 (1),	 select	 the	

Developer	check	box	(2):	

	
In	order	to	run	the	macros	that	we	will	create	with	our	reports,	we	need	to	ensure	that	
the	Security	level	in	Excel	is	appropriate:	

1. On	the	Developer	tab,	click	 .	
2. Enable	all	macros:	
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3. Click	 	 to	close	the	Trust	Center.	

4. On	the	Developer	tab,	click	 .	
The	following	screen	displays:	
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5. Ensure	that	the	Microsoft	ActiveX	Data	Objects	Library	is	available:	
5.1. Select	Tools>References	in	the	Menu	bar	

In	 the	 References	 –	 VBAProject	 dialog	 that	 displays,	 make	 sure	 that	 the	
following	checkbox	is	checked:	
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5.2. Click	 .	
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Step	2:	Design	the	report	in	Excel	
1. Double‐click	Sheet1	in	the	VBAProject	pane:	

	
2. Copy	and	paste	the	following	VB	code:	

Sub OpenAdoFile()	
    Dim RecordSet As ADODB.RecordSet	
    Dim Worksheet As Excel.Worksheet	
    Dim h As Long	
    Dim col As Long	
    Dim datarow As Long	
    Dim source As String	
	
    ' Get the persisted record set	
    source = Environ("LocalAppData") & "\KESoftware\ 
Reports\ecatalogue\xmldata.xml"	
    Set RecordSet = New ADODB.RecordSet	
    RecordSet.Open source, "Provider=MSPersist"	
   	
    ' Get the active page to send the data to	
    Set Worksheet = ThisWorkbook.ActiveSheet	
    Application.Visible = True	
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    ' Put out all of the column headers	
    col = 1	
    ListColumnNames Worksheet, RecordSet, col	
       	
    ' Print out all the row data	
    While Not RecordSet.EOF	
        col = 1	
        datarow = datarow + 1	
        For h = 0 To RecordSet.Fields.count - 1	
                Worksheet.Cells(datarow + 1, col).Value = 
RecordSet.Fields(h).Value	
                col = col + 1	
        Next	
        RecordSet.MoveNext	
    Wend	
           	
    Worksheet.Range("A1").CurrentRegion.Select	
    Worksheet.Columns.AutoFit	
    Set RecordSet = Nothing	
End Sub	
	
Private Sub ListColumnNames(ByVal ws As Excel.Worksheet, ByVal rs 
As ADODB.RecordSet, ByRef col As Long)	
    Dim i As Long	
    ' Loop through the record set pulling out the column names	
    For i = 0 To rs.Fields.count - 1	
            ws.Cells(1, col).Value = rs.Fields(i).Name	
            col = col + 1	
    Next	
End Sub	
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3. Double‐click	 ThisWorbook	 in	 the	 VBAProject	 pane	 and	 copy	 and	 paste	 the	

following	code:	
Sub Workbook_Open()	
' Load up the ADO File	
Sheet1.OpenAdoFile	
End Sub	
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4. Save	the	report	and	upload	it	to	your	EMu	report	(page	24)	on	the	Report	Type	tab	

of	the	Report	Properties	box.	

When	the	report	is	run	in	EMu,	an	Excel	report	is	generated:	
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How	to	create	an	Excel	Report	with	
nested	tables	using	the	ADO	RecordSet	

1. Repeat	Step1:	Create	a	new	report	in	EMu	(page	24).	
For	this	example,	the	following	fields	were	selected.	Note	the	two	nested	tables	‐	
Creator's	Name	and	Physical:	

	

2. In	Excel,	click	 	 on	the	Developers	tab.	
3. Double‐click	Sheet1	in	the	VBAProject	pane:	
4. Copy	and	paste	the	following	VB	code:	
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Sub Read_XML_Data()	
	
    Dim rst As ADODB.Recordset	
    Dim Worksheet As Excel.Worksheet	
    Dim i As Long	
    Dim j As Long	
    Dim source As String	
    Dim datarow As Long	
    Dim saverow As Long	
    Dim lastrow As Long	
    Dim col As Long	
   	
    ' These next declaration is a little odd. Its needed in cases 
where the entire value	
    ' of a nested table is blank. In these cases it is necessary 
to force a number of columns to be skipped when printing	
    ' out field values. Oddly, as long as a nested table has at 
least one value, then there is no issue.	
    ' There is only a need to declare one variable for each nested 
table.	
    ' In this example there are only two nested tables so two 
declarations are needed	
    ' The value assigned to each variable will depend on the 
number of fields in that nested table.	
    ' In this example the first nested table is the 
CreCreatorRef_tab, which has two fields, i.e. NamFirst and 
NamLast	
    ' and the second nested table, i.e Physical, has 3 fields, 
i.e. PhyType, PhyHeight and PhyWidth	
   	
    Dim firstnestedtable As Long	
    Dim secondnestedtable As Long	
    Dim nestedtablecount As Long	
   	
    firstnestedtable = 2	
    secondnestedtable = 3	
    nestedtablecount = 1	
                   	
    ' Get the persisted record set	
    source = Environ("LocalAppData") & 
"\KESoftware\Reports\ecatalogue\xmldata.xml"	
    Set rst = New ADODB.Recordset	
    rst.Open source, "Provider=MSPersist"	
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    ' Get the active page to send the data to	
    Set Worksheet = ThisWorkbook.ActiveSheet	
    Application.Visible = True	
       	
    'Add column labels	
    Worksheet.Cells(1, 1).Select	
    ActiveCell.EntireRow.Insert	
    Worksheet.Cells(1, 1).Value = "Record No"	
    Worksheet.Cells(1, 2).Value = "IRN No"	
    Worksheet.Cells(1, 3).Value = "Title"	
    Worksheet.Cells(1, 4).Value = "Date Created"	
    Worksheet.Cells(1, 5).Value = "Creator First"	
    Worksheet.Cells(1, 6).Value = "Creator Last"	
    Worksheet.Cells(1, 7).Value = "Physical Type"	
    Worksheet.Cells(1, 8).Value = "Physical Length"	
    Worksheet.Cells(1, 9).Value = "Physical Width"	
       	
    col = 1	
    ' Start printing data from Row 3	
    datarow = 3	
    lastrow = datarow	
    While Not rst.EOF	
        col = 1	
          	
        If datarow < lastrow Then	
            datarow = lastrow	
        End If	
           	
        For j = 0 To rst.Fields.Count - 1	
            If rst.Fields(j).Type = adChapter Then	
                If rst.Fields(j).Value.BOF Then	
                    Worksheet.Cells(datarow, col).Value = ""	
                    If nestedtablecount = 1 Then	
                        col = col + firstnestedtable	
                        nestedtablecount = nestedtablecount + 1	
                    ElseIf nestedtablecount = 2 Then	
                        col = col + secondnestedtable	
                        nestedtablecount = nestedtablecount + 1	
                    End If	
                Else	
                    If rst.Fields(j).Value.EOF Then	
                        Worksheet.Cells(datarow, col).Value = ""	
                        If nestedtablecount = 1 Then	
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                            col = col + firstnestedtable	
                            nestedtablecount = nestedtablecount 
+ 1	
                        ElseIf nestedtablecount = 2 Then	
                            col = col + secondnestedtable	
                            nestedtablecount = nestedtablecount 
+ 1	
                        End If	
                    Else	
                        saverow = datarow	
                        ListNestedValues Worksheet, 
rst.Fields(j).Value, col, datarow, lastrow, saverow, 
nestedtablecount	
                    End If	
                End If	
            Else	
                If IsNull(rst.Fields(j).Value) Then	
                    Worksheet.Cells(datarow, col).Value = ""	
                Else	
                    Worksheet.Cells(datarow, col).Value = 
rst.Fields(j).Value	
                End If	
                col = col + 1	
            End If	
        Next	
        rst.MoveNext	
        datarow = datarow + 1	
        nestedtablecount = 1	
    Wend	
    	
    'Closing the recordset.	
    rst.Close	
    	
    'Release object from memory.	
   	
    Worksheet.Range("A1").CurrentRegion.Select	
    Worksheet.Columns.AutoFit	
    Set rst = Nothing	
    	
End Sub	
	
Private Sub ListNestedValues(ByVal ws As Excel.Worksheet, ByVal 
rs As ADODB.Recordset, ByRef col As Long, ByRef datarow As Long, 
ByRef lastrow As Long, ByRef saverow As Long, ByRef 
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nestedtablecount As Long)	
    Dim i As Long	
    Dim j As Long	
    Dim startrow As Long	
      	
    ' Loop through a nested table pulling out the row values	
    j = 0	
    startrow = saverow	
    While Not rs.EOF	
        max = 1	
        j = col	
        For i = 0 To rs.Fields.Count - 1	
            ' Don't print key values	
            If rs.Fields(i).Name <> "ecatalogue_key" And 
rs.Fields(i).Name <> "CreCreatorRef_key" And rs.Fields(i).Name <> 
"Physical_key" _	
            Then	
                If IsNull(rs.Fields(i).Value) Then	
                    ws.Cells(startrow + 1, j).Value = ""	
                    j = j + 1	
                Else	
                    If rs.Fields(i).Type = adChapter Then	
                        ListNestedValues ws, rs.Fields(i).Value, 
j, datarow, lastrow, saverow, nestedtablecount	
                        datarow = startrow	
                    Else	
                        ws.Cells(startrow, j).Value = 
rs.Fields(i).Value	
                        j = j + 1	
                    End If	
                End If	
            End If	
        Next	
        rs.MoveNext	
        startrow = startrow + 1	
    Wend	
   	
    If (j > 0) Then	
        col = j	
    End If	
   	
    If startrow > lastrow Then	
        lastrow = startrow	
    End If	
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    nestedtablecount = nestedtablecount + 1	
End Sub	

5. Double‐click	 ThisWorbook	 in	 the	 VBAProject	 pane	 and	 copy	 and	 paste	 the	
following	code:	
Sub Workbook_Open()	
' Load up the ADO File	
Sheet1.Read_XML_Data	
End Sub	

6. Save	the	report	and	upload	it	to	your	EMu	report	(page	24)	on	the	Report	Type	tab	
of	the	Report	Properties	box.	

When	the	report	is	run	in	EMu,	an	Excel	report	is	generated:	
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Registry	entries	
The	Type	Registry	entry	indicates	which	export	type	to	use	for	each	report	request.	

The	format	of	this	Registry	entry	is	;	

System|Setting|Reports|Type|Crystal CSV|value	

	 value	 is	0	or	1:	

 	 0	 Generates	data	in	the	existing	format.	

 	 1	 Generates	data	in	the	new	Crystal	ODBC	format.	

 	
	 If	this	entry	is	not	present,	a	value	of	0	is	assumed.	

System|Setting|Reports|Type|Crystal ADO|value	

	 value	 is	0	or	2:	

 	 0	 Generates	data	in	the	existing	format.	

 	 2	 Generates	data	in	the	new	Crystal	ADO	record	set.	

 	
	 If	this	entry	is	not	present,	a	value	of	0	is	assumed.	

System|Setting|Reports|Type|Microsoft ADO|value	

where:	

	 value	 is	0	or	3:	

 	 0	 Generates	data	in	the	existing	format.	

 	 3	 Generates	data	in	the	new	Microsoft	ADO	format.	

 	
	 If	this	entry	is	not	present,	a	value	of	0	is	assumed.	
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